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  HTMLبديل لغة  XMLلغة 
 في مجال المكتبات والمعلومات

 
 

 اخلاص عبد الامير سوادي م.م.
 

 الملخص:
يسعى البحث الىى ععفةىا الائى ال الئى  

 XMLئحصىىىىىىا بتيبىىىىىى  بئ بيىىىىىى  ل ىىىىىىا 
ةىى  العبئبىى    HTMLبىىليا بىىة ل ىىا 

وعفابىىىل العبئبىىى   الىىى ةا الىىىى ععفةىىىا 
أسىىىىب و ئحويىىىىا الاصىىىىو  عىىىىة والىىىىى 

XML   وهىىىىىدى احىىىىىلت التع ليىىىىى   الئىىىىى
يقىىىوه ببىىى  عحىىىفف الاصىىىو  ويئ تىىىو 
دلىىىىت اسىىىىئولاه عرعوبىىىىىا عحىىىىفف  عىىىىىة 

 القوابل الو صا ب لئعتيه.
 ئوصا البحث الى اة:

لب  ق بتيا احئواء  XMLل ا   -1
البي ا   واقتب  وئولياب  ببس 

HTML    عبعئب  اة ئظبف البي ا
 ةق .

اثبئ  هدى الت ا  في  لتعبفعرية  -2
وسيتا    واقتب  لآاب  الى بعا 

ئئع عا عع أاوابب  البي ا   وليس    
 ةق .

 :المشكلةتحديد 
يعبىىىىىىىة ئحليىىىىىىىل ع ىىىىىىىبتا البحىىىىىىىث ةىىىىىىى  

 الإر با لى السؤاا الائ :
ع  أوره الئ  به والاوئلاف ع  بية ع  

 HTMLو  XMLبىىىىىية ل ىىىىىا البفعرىىىىىا 
الو صىىىىا بتىىىىى ئوليىىىىع البي اىىىى   بتىىىىى 
صىىىىىىىىىىىتحا الويىىىىىىىىىىىىو وعىىىىىىىىىىى  الئ ىىىىىىىىىىىىوفا  

 HTMLالعصىىى حبا لتئحىىىوا الىىىى ل ىىىا 
وعىىىىىلت الإةىىىىىى ل  عابىىىىى  لىىىىىىلت العىىىىىى عتية 
والعسىىىىىىئتيلية ةىىىىىى  العبئبىىىىىى   وعفابىىىىىىل 

 الععتوع  .
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 الأهداف
 تهدف الدراسة

 XMLالئعفف بتى وظ اف ل ا  -1
 .HTMLو 
الئعفف بتى علت الاوئلاف بية  -2

وع  ال  ء  HTMLو  XMLالت ئية 
 الدي يرعع بيابع . 

الئعفف بتى أسب و أهعيا  -3
 HTMLالى  XMLالئحوا عة ل ا 

 ب لاسبا لتعبئب   وعفابل الععتوع  .
الئعفف بتى لوف الئحوا ب لاسىبا  -4

لتعسىىىىىىىىىئتيلية ةىىىىىىىىى  الحصىىىىىىىىىوا بتىىىىىىىىىى 
 البي ا  .

 أهمية البحث
ليس  ل ا بفعريا ااب   XMLاة ل ا 

 Markupئائع  الى ل ا الئفعيل 
Language  لئس بل بتى ئفعيل

وئاسي  العسئالا  والفس اا 
الالبئفوايا ببف الاائفا  وئئعيل 
ب اتا ل    الئفعيل بفسوعب  دا  
العثتا وببيبتيئب  ال بيبا ب ل رف  
ب لإل ةا الى ااب  لا ئحئوي بتى 
أواعف او بعتي   ووظيتئب  ئاحصف 
بتى ئفعيل الاصو  بئفعيل 

ئتبعب  رعيع الاصو  بئفعيلى ععياا 
الصتح  . وئبعة أهعيا البحث ة  
اير ل ل ا ئبوة سبتا لبا العبفعرية 
بحيث ئبوة وسيتا لحتظ البي ا   
ال ةا اة الاسئائ ر   يعبة اة 
ئولح أهعيا هدى الت ا والئ  ه  

بحيث لا ئئحلل HTMLبليتا بة ل ا 
ة  عحفت واحل ال ةا الى ع  ئحققه 

لية ة  بعتيا الئحوا ب لاسبا لتعسئتي
 الحصوا بتى البي ا  .

 نبذة تاريخية
لعفض  XMLئعل اسئولاه 

الععتوع   الليا عيبيا بفة  عة قبا 
ا  في الابلاه ة  أواوف الثع ايا   
او عائصف السبعيا   الا اة ظبوف 

ثه أرفي   1691ب ه  XMLل ا الى 
بتيب  البثيف عة الئعليلا  ائيرا 
الع  با الئ  ب ا  اواره الويو وة  

 وف روة  1669 – 1661ب ه 
بوست حيث حسة العلاق   عع 

  XMLالعرعوب   الص يف  لئرفبا 
الى الويو عة ولاا  فبا 

 ع يبفوسوة .
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له ئئرعع وره  XMLاع  عرعوبا الى 
عة لوره لئصعيه اار ل عرعوبا 

البفيل الالبئفوا  والعؤئعفا  الب ئتيا 
 XMLأارل   1661ةت  ب ه 

اهلاف عرعوبا الععا عع اسئولاه 
وئسبيا  XMLالاائفا  والئواة  

ئه  2112العع لرا لتبفاعل اع  ب ه 
عع  XMLلعل ال بعا الث ايا الى 

ال بعا الث لثا بعل ئاقيح الأو  ء 
 .(1)2114وصلف  ب ه 

  XMLتعريف لغة 
ل ا ليس لب  وسوه عحلل  ه  

بع وف ويو ئصاع وسوعت باتست 
لت ع ت  الحفيا ببئ با الوسيوبه 
الئ  يفغو بب  لدلت يصبح لليا  بلل 
غيف عائب  عة الوسوه الئ  يعبة 
بئ بئب  ببف الت ا وه  ئاحلف عة 

والئ  ظبف  ب ه  SGMLالت ا الاه 
وئئعيل ب اتا ل    الئفعيل  1691

عثتثا وهيبتب  بوسوع   دا  اقواس 
 .(2)ال رفي

  HTMLلغة 
ه  ل ا ئباى بب  صتح   العواقع 
وه  عوئصف  عة الئسعيا الإابتيليا 

Hyper Text Mark – up 
language    وه  بب ف  بة عتت

اصيا ب ليا يئوتتب  ع  يسعى 
بواس ا هدى الوسوه يقوه  (وسوه)ال

العئصتح   بعفض الا  ب ل با 
العا سو لبا وسه وه  ئسئوله 
ل فض بفض البي ا   بتى صتحا 

 .(3)ويو
بصفحات  XSLو  XMLاستخدام 

 ويب
( XMLل ا الئعييل الق بتا للاعئلال )

ه  ل ا ئئيح لت هيبتا الععتوع   
، ئع عً  عثا XMLحيث ئئيح لت ل ا 

ععتوع ئت ، هيبتا HTMLل ا 
ب سئولاه العلاع  ، الا أة بلاع   

ليس  عحلل  عسبقً  عثا  XMLل ا 
با ئئيح لت ل ا  HTMLبلاع   

XML  بللًا عة دلت، اعب ايا اا  ء
بلاع   ئعفَّف هيبا البي ا   
الو   )عو  (، وئبوة العلاع   
عئلاوتا عع بعلب  البعض لإا  ء 
عو   عة العلاع   الأصتيا 

ععظه بلاع    والئ بعا وعثا
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HTML   يحئوي عو ،XML  بتى
غلا .  بلاع   ةئح وا 

 XMLيعبات ئسعيا وهيبتا بلاع   
بأي  فيقا،  في ا أة ئععا بتى 
ئلاوا العلاع   ئب بً  ة  العلاع   
الأوفت، وأة ئعيَّة لبا بلاعا ةئح 

لا ئحئوي  بلاعا غت  ع  بقا.
 –بتى أيا ئاسي   XMLعسئالا  

ةب  بب ف  بة ح وي   لتبي ا   
العبيبتا ةق ، وبعرفل أة يصيف 

، يعبات اسئولاه XMLلليت عو   
ل ا صتح   الأاع   العوسَّعا 

(XSL لعفض الععتوع  ، وباتس )
ال فيقا الئ  ئئيح لت بب  
Cascading Style Sheets 

(CSS)  ئاسي  ل اHTML ئئيح ،
عوسَّعا ال  ل ا صتح   الأاع  

يعبات ئعفيف  XMLئاسي  بي ا   
الأاع   وبا صف الصتحا 

 XMLوالئو ي    الخ ة  عتف 
بحيث أاه بالع  يفت العسئوله 

ة  العسئعفض، يئه  XMLبي ا   
ئاسي  البي ا   وةقًَّ  لع  قع  بئعفيته 

وئبوة العحئوي    XSLة  عتف 

( والعفض الدي يحللى XMLبي ا   )
ئع عً ، وهو ( عاتصتية (XSLعتف 

ع  يوةف لت سي ف  أببف بتى بيتيا 
بفض الععتوع   بتى صتحا 

 XSLالويو. والولاصا ئعل ل ا 
، ئبوة XMLئباولوري  بفض لت ا 

ةيب  العوفر   الأس سيا صتحا 
HTML. 

ئحويلا  ل ا صتح   الأاع   
(XSLT ه  ل ا ةفبيا عة ل ا )

XSL  الئ  ئئيح لت ب لتعا بفض
يو، ويحولب  بي ا   بتى صتحا و 

، الى ععتوع   XSLعع أاع   
عاسقا يعبة قفاءئب  ة  صوف  

HTML  يعبات اسئولاه
Dreamweaver    لإا  ء صتح

XSLT   الئ  ئئيح لت ارفاء ئحويلا
XSL  ب سئولاه و له ئ بيق   او

 XSLعسئعفض ة  بعتيا ئحويا 
عة ر او الو له، يقوه الو له بئاتيد 

 XSLو  XMLبعتيا ئحويا 
لب  بتى الصتحا ة  بعتيا وبف 

الئحويا عة ر او الععيا، يقوه 
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 Internetالعسئعفض عثا )
Explorer .بئاتيد الععا ) 

الابل الدي ئئودى اب ايً  )الئحويلا  
عة ر او الو له عق با الئحويلا  
عة ر او الععيا( يعئعل بتى ع  
ئح وا ئحقيقه بائيرا اب ايا 

يا الئباولوري  العئ حا وعسئوت اعب ا
الوصوا الئ  لليت الى عتف عصلف 

XML الى ر او بواعا أوفت ،
ولبا عة العابرية ةواالى وقيولى 
بتى سبيا العث ا ئععا الئحويلا  
عة ر او الو له ة  با 
العسئعفل  ، بياع  ئبوة الئحويلا  
عة ر او الععيا عقصوف  بتى 
العسئعفل   الحليثا ةق  )بتى 

 Internet Explorer6سبيا العث ا 
و  Mozilla 1.8و  Netscape8و 

Firefox 1.0.2 حيث ئئيح لت )
الئحويلا  عة ر او الو له بفض 

ليا عيبيًّ  عة الو له  XMLبي ا   
الو   بت أو عة أي عب ة آوف 
بتى الويو، بياع  يرو أة ئسئوله 
الئحويلا  عة ر او الععيا بي ا   

XML  الئ  يسئليتب  عسئعفض

الويو الو   بت عحتيً  وأويفاً، 
ئئ تو عات الئحويلا  عة ر او 
الو له ا ف الصتح   بتى و له 
ئ بيق   ئع  ئبيائه، بياع  ئئ تو 
الئحويلا  عة ر او الععيا الوصوا 

 .(4)ةق  الى و له ويو
 من جانب الخادم XSLتحويلات 

 فقً   Dreamweaverئوةف لت 
ئئيح لت  XSLTلإا  ء صتح   

عة ر او  XSL  ئحويا بعتي 
الو له. بالع  ياتد أحل وواله 

، يعبة XSLالئ بيق   بعتيا ئحويا 
أة يورل العتف الدي يحئوي بتى 

بتى الو له الو    XMLبي ا   
بت، أو ة  أي عب ة آوف بتى 
الويو ب لإل ةا الى دلت، يعبة أة 
لا.  يعفض العسئعفض البي ا   العحوَّ
وأويفاً، يعل ا ف الصتح   

تئحويلا  عة ر او الو له  ياً  ل
ععقلاً ويئ تو أة يبوة لليت اعب ايا 

 وصوا الى و له ئ بيق  .
عة  XSLبال الئع عا عع ئحويلا  

ر او الو له، يعبات اسئولاه 
Dreamweaver    لإا  ء صتح
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XSLT   الئ  ئقوه بإا  ء عسئالا
HTML    صتح(XSLT  أو )ب عتا
لء الدي يقوه بإا  ء ر XSLTأرلاء 

ئبوة صتحا  HTMLعة عسئال 
XSLT  الب عتا ع  ببا لصتحا
HTML  الععئ ل . ةبو يحئوي بتى
، <head>وبلاعا  <body>بلاعا 

ويئيح لت بفض عرعوبا عة بي ا   
HTML  وXML  بتى الصتحا رلء
XSLT   هو رلء عة الفعول، الئ

يسئولعب  عسئال يعفض بي ا   
XML  العاسَّقا. وولاةً  لصتحا

XSLT  العبئعتا، يعل عتتًّ  عسئقلًا
أو  <body>يحئوي بتى بلاعا 

<head>  ادا با  ئفغو ة  بفض
عسئقتا، قه  XMLبي ا   ة  صتحا 

عبئعتا، وافب   XSLTبإا  ء صتحا 
الئ  لليت بب ، وبتى  XMLبي ا   

الر او الآوف، ادا با  ئفيل بفض 
ة  قسه ععية عة  XMLبي ا   

بتى  –صتحا ليا عيبيا عورول  
سبيا العث ا، صتحا فايسا ليا عيبيا 
لعئرف عائر   في ليا، عع ائ ال 

ععفولا  RSSفي ليا عة عورل 

قه بإا  ء  –بتى ر او الصتحا 
وألوا عفرعً  له ة   XSLTرلء 

الصتحا الليا عيبيا اا  ء أرلاء 
XSLT    واسئولاعب  عع صتح

ليا عيبيا أوفت لعفض بي ا   
XMLثف  يوبً .، وهو السيا فيو الأب 

ويعل ال فض عة الو و  الأولى الئ  
ئئعثا ة  اا  ء هدى الأاواع عة 

 XSLTالصتح   هو اا  ء رلء 
وهو عتف عاتصا يحئوي بتى 

 XMLئو ي  وئاسي  الخ لبي ا   
الئ  ئفيل ة  الاب يا بفلب  ة  
الصتحا الليا عيبيا. وبعرفل اا  ء 

، ئقوه بإلو ا عفرع له XSLTرلء 
لليا عيبيا )بتى سبيا ة  صتحئت ا

 Coldأو صتحا  PHPالعث ا 
Fusion ويععا العفرع الدي ئه )

الو له الى الرلء بصوف  ع  ببا 
( SSI) –لتئلعية عة ر او الو له 

العاسَّقا )الرلء(  XMLوئورل بي ا   
ة  عتف عاتصا أثا ء ورولى ة  

، ويظبف Design فيقا العفض 
باصف ا او لترلء بتى الصتحا 

 عيبيا اتسب ، وبالع  ي تو الليا
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العسئعفض الصتحا الليا عيبيا الئ  
ئحئوي بتى عفرع لترلء، يقوه الو له 
بعع لرا الئعتيع   العلعَّاا ويقوه 
بإا  ء عسئال رليل ئظبف ةيه 
العحئوي   العاسَّقا لترلء بللًا عة 

 العاصف الا او. 
ي تو العسئعفض صتحا  -1

 ليا عيبيا.
الصتحا يعثف و له الويو بتى  -2

 ويعففه  الى و له الئ بيق  .
يتح  و له الئ بيق   الصتحا  -3

بحثً  بة ئعتيع   ويحصا بتى رلء 
XSLT. 

ياتد و له الئ بيق   الئحويا )يقفأ  -4
ويحصا بتى بي ا    XSLTرلء 
XML .) وياسقب 

يقوه و له الئ بيق   بإلفاج الرلء  -1
العاسَّ  الى الصتحا، ثه يعففى عف  

 ويو.أوفت الى و له ال
يفسا و له الويو الصتحا  -9

 الاب ايا الى العسئعفض.
 XSLاسئوله ستوت و له ئحويا 
 XSLTلإلو ا العفرع الى رلء 

صتحا ليا عيبيا بالع  ئقوه بإلو ا 

 Dreamweaverعفرع، يقوه 
 MM_XSLبإا  ء عرتل / 

Transform/ includes  ة  العرتل
الردف لتعوقع الدي يحئوي بتى عتف 
عبئبا وق  الئ  يا ويسئوله و له 
الئ بيق   الوظ اف العحلل  ة  هدا 

 XMLالعتف بال ئحويا بي ا   
العحلل . ويبوة العتف عسؤولًا بة 

وأرلاء  XMLاحل ف بي ا   
XSLT وئاتيد ئحويا ،XSL وفاج ، وا 

ويرو أة  الائ ال بتى صتحا الويو.
ة العتف بال ئحويا بي ا   يبو 

XML  العحلل . ويبوة العتف عسؤولًا
وأرلاء  XMLبة احل ف بي ا   

XSLT وئاتيد ئحويا ،XSL وفاج ، وا 
 الائ ال بتى صتحا الويو.

ويرو أة يبوة باِّ عة العتف الدي 
وعتف  XSL Tيحئوي بتى رلء 

XML  ،  الدي يحئوي بتى البي ا
 وعتف عبئبا وق  الئ  يا الدي ئه
اا  ؤى بتى الو له عة أرا بفض 
صتحئت بصوف  صحيحا )ادا اوئف  

 –بعيل بعصلف البي ا    XMLعتف 
بتى سبيا  RSSعتف عة عتقه 
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يرو أة يبوة هدا العتف  –العث ا 
 ب ل بع ة  عب ة آوف بتى الإائفا .
يعبات أيلً  اسئولاه 

Dreamweaver    لإا  ء صتح
XSL T  عبئعتا لاسئولاعب  عع

لا  عة ر او الو له، وئععا الئحوي
العبئعتا باتس  XSL Tصتحا 

، ةق  بالع  XSL T فيقا رلء 
ئقوه بإلو ا العفرع الى صتحا 

XSL T  العبئعتا ب سئولاه ستوت
، حيث ئقوه XSLو له ئحويا 

بإلو ا العحئوا  الب عتا لصتحا 
HTML  وب لئ ل  يرو الالا با
HTML  عة الصتحا الليا عيبيا
الئ   aspأو  php أو cfm)صتحا 

ئععا بصتحا ح ويا( قبا أة ئقوه 
بإلو ا العفرع. يلبه 

Dreamweaver   ئحويلاXSL 
 ASPو  ColdFusionلصتح   

 .php(1)و
 من جانب العميل XSLتحويلات 

بتى  XSLيعبات ئاتيد ئحويلا  
الععيا بلوة اسئولاه و له ئ بيق  . 

 Dreamweaverيعبات اسئولاه 

ئقوه بدلت،  XSLTلإا  ء صتحا 
وعع دلت ئئ تو الئحويلا  عة 

 XMLر او الععيا عع لرا عتف 
الدي يحئوي بتى البي ا   الئ  ئفيل 
بفلب  ب لإل ةا الى دلت، سئععا 
الئحويلا  عة ر او الععيا ة  
العسئعفل   الحليثا ةق  )بتى 

و  Internet Explorer 6سبيا 
Netscape 8  وMozilla 1.8  و

Firefox 1.0.2عليل عة ( ل
الععتوع   بة العسئعفل   الئ  لا 

 .XSL(9)ئلبه ئحويلا  
 XSL Tأولًا، قه بإا  ء صتحا 

 XMLعبئعتا وألح  عصلف بي ا   
بتى الح    Dreamweaverيحثت 

عصلف بي ا   بالع  ئقوه بإا  ء 
صتحا رليل . يعبات اا  ء صتحا 

XSL T  عة الصتف، أو يعبات
عورول  الى  HTMLئحويا صتحا 

يرو بتيت الح    XSL Tصتحا 
ب سئولاه لوحا  XMLعصلف بي ا   

Bindings 
(Window>Bindings.) 
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، XSL Tبعل أة ئقوه بإا  ء صتحا 
الدي  XMLيرو أة ئفب ب  بعتف 

بة  في   XMLيحئوي بتى بي ا   
 XSL Tالو ا عفرع الى صتحا 

اتسه ) ة  الأغتو  XMLة  عتف 
ئقوه بإلو ا عفرع الى صتحا أاع   

CSS  ة  القسه<head>  عة
يرو أة يفت لاافو  HTMLصتحا )

وليس صتحا  XMLعوقعت عتف( 
XSL T  ة  عسئعفض بالع  يفت

لواف عوقعت الصتحا، ياتد 
، ويعفض XSLالعسئعفض ئحويا 

، العاسقا حسو صتحا XMLبي ا   
XSL T .العفئب ا 
و  XSL Tقا بية صتح   هدى العلا

XML  العفئب ا ئبوة عئ  ببا
اظفيً ، لباب  ئبوة عوئتتا بة اعودج 

حياع  يبوة  CSS/HTMLصتحا 
ئحئوي بتى  HTMLلليت صتحا 

عحئوي   )عثا ا (، ئسئوله 
صتحا أاع   و فريا لئاسي  

 العحئوت.
العحئوي  ،  HTMLئحلل صتحا 

البفعرا  CSSبياع  ئحلل ئعتيعه 
الئ  لا يفاه  العسئوله  الو فريا،

 XMLو  XSL Tأبلاً، العفض عع 
 XMLياعبس الولع. ويحلل عتف 

الدي لا يفاى العسئوله أبلاً ة  
صوفئه الأوليا، العحئوي   بياع  

العفض وئحئوي  XSLTئحلل صتحا 
بتى الرلاوا  XSLTصتحا 

والئو ي  والفسوه وغيفه  عة الأ ي ء 
الئ  ئحئوي بتيب  ب ل  صتح   

HTML  القي سيا بالع  يفت أحل
ة  عسئعفض  XMLاللواف عتف 

بئاسي   XSL Tئقوه صتحا 
 العحئوت. 
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 .XMLي تو العسئعفض عتف  -1
 الى العسئعفض. XMLيسئريو الو له بإفس ا عتف  -2
 .XSL Tويسئلب  عتف  XMLيقفأ العسئعفض ئوريه  -3
 الى العسئعفض. XSL Tيفسا الو له عتف  -4
ا العسئعفض بي ا    -1  ويعفلب  ة  العسئعفض. XMLيحوِّ

 Dreamweaverبالع  ئسئوله 
بصتحا  XSL Tلفب  صتحا 

XML ،Dreamweaver  ألوا
الئعتيعا البفعريا العا سبا لت ة  

ادا ب ا  لليت  XMLأبتى صتحا 
ئقوه بفب ب  )هدا ادا  XMLصتحا 

عورول حصفيً  بتى  XMLب ة عتف 
عسئعفض الويو الو   بت، ةبا 
ع  ئحئ ج الى بعته هو اسئولاه 

Dreamweaver  لإلو ا الئعتيعا

البفعريا العلااعا الئ  ئفب  
الصتحئية. بالع  يبوة لليت عتف 

XML  ئبوة ئحويلا ،XSL   الئ
ياتده  الععيا ليا عيبيا ب لب عا. 

ث أاه بالع  ئقوه بئحليث بحي
، سيئه ئتق ايً  XMLالبي ا   ة  عتف 

الئ   HTM Lئحليث عوفر   
العفئب ا  XSL Tئسئوله صتحا 

 بال الو ا الععتوع   الرليل .
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يرو أة ئبوة عتت    ملاحظة:
XML و XSL   الئ  ئسئولعب

لتئحويلا  عة ر او الععيا عورول  
ة  اتس اللليا. ادا له ئبة عورول ، 

 XMLيقفأ العسئعفض عتف س
لتئحويا، لباه لة يارح ة  العثوف 
بتى الأصوا )صحيتا الأاع   
والصوف وغيفه ( الئ  ئحلله  
الافئب     دا  الصتا ة  صتحا 

XSL T . 
الئ   XMLادا له ئبة لليت صتحا 

ئقوه ب لفب  اليب  ) بتى سبيا 
العث ا، ادا با  ئفغو ة  اسئولاه 

ة   RSSعة عتقه  XMLبي ا   
عب ة ع  ب لو فج بتى الويو، سيبوة 
سيف الععا أبثف ئعقيلاً، لإرفاء 
الئحويلا  عة ر او الععيا 

عة عصلف  XMLب سئولاه بي ا   
و فر ، يرو بتيت أولًا ئاليا عتف 

الى اتس اللليا الدي  XMLعصلف 
بالع   XSL Tئورل ةيه صتحا 

ة  عوقعت  XMLئبوة صتحا 
العحت ، يعبات اسئولاه 

Dreamweaver  لإل ةا الئعتيعا

البفعرا العلااعا الئ  ئفب ب  بصتحا 
XSL T وئقوه با ف بتئ  الصتحئية ،
الدي ئه ئاليته وصتحا  XML)عتف 

XSL T  .العفئب ا( الى و له الويو
 XMLبالع  يفت العسئوله صتحا 
 XSLTة  العسئعفض، ئقوه صتحا 

بئاسي  العحئوي   بع  ة  العث ا 
 الس ب .
العيو ة  ارفاء ئحويلا   ويئعثا
XSL    عة ر او الععيا بتى بي ا
XML   الئ  ئأئ  عة عصلف و فر

ئبوة "  XMLة  أة بي ا   
ليا عيبيا " رلايً . ويبوة عتف 

XML  "  الدي ئالله وئعلله هو ةق
لق ا " عة العتف العورول ة  عب ة 
آوف بتى الويو. ادا ب ه عتف 

XML  الأصت  بعيلاً بال ارفاء
ئ ييفا  الويو، يرو بتيت ئاليا 
العتف عف  أوفت وفب ه بصتحا 

XSL T وئعيل ا ف عتف ،XML 
بتى و له الويو. حيث يعفض 
العسئعفض ةق  البي ا   الئ  يئتق ه  

العورول بتى و له  XMLعة عتف 
الويو الو   بت، وليس  البي ا   
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 XMLالئ  يحئويب  عتف عصلف 
 ت . الأص

 وعناصر التكرار XMLبيانات 
لعا قا الئبفاف  XSLTيئيح لت ب اة 

اعب ايا بفض با صف الئبفاف عة 
لاوا صتحا. ويعبة  XMLعتف 

ئحويا أي عا قا ئحئوي بتى 
الى  XMLباصف ا او بي ا   

عا قا عبفف ، الا أة العا    الأبثف 
 يوبً  ه  رلوا أو صف برلوا أو 

 ستستا عة صتوف الرلاوا.

يعفض العث ا الئ ل  بيف يئه ئ بي  
لعا قا الئبفاف بتى  XSL Tب اة 

صف رلوا يعفض ععتوع   ق اعا 
لع عه، يعفض الصف الأول  ثلاثا 

 XMLبا صف عوئتتا عة عو   
وه  الصاف والوصف والسعف. بال 

لعا قا الئبفاف  XSL Tئ بي  ب اة 
بتى صف الرلوا، ويقوه و له 
ا ئ بيق   أو عسئعفض بعع لر

الصتحا، يئبفف الرلوا ببي ا   
ةفيل  يئه الو لب  ة  با صف رلوا 

 رليل.
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 XSL Tبالع  ئقوه بئ بي  ب اة 

لعا قا الئبفاف بتى باصف ة  
، يظبف حل فقي  Documentالا ةد  

عبوو فع لي حوا العا قا العبفف . 
بالع  ئقوه ب سئعفاض بعتت ة  

 File > Preview inبعسئعفض )
Browser يوئت  الحل الفع لي ،)

ويعئل الئحليل لعفض با صف الئبفاف 
، عثا XMLالعحلل  ة  عتف 

 الئوليح الس ب . 
لعا قا  XSL Tبالع  ئليف ب اة 

وة  وا الئبفاف الى الصتحا، يب
ة   XMLالعاصف الا او لبي ا   

بئحليث  Dreamweaverالا ةد  
 XMLل ا عس ف(  XPathئعبيف )

بحيث  XMLلتعاصف الا او لبي ا   
 يبوة عئعتقً  بعس ف باصف الئبفاف.

بتى سبيا العث ا، الئعتيعا البفعريا 
الئ ليا ه  لرلوا يحئوي بتى 
باصفية ا ابية ليا عيبيية، بلوة 

لعا قا ئبفاف  XSL Tة ئ بي  ب ا
 بتى الرلوا.

بإا  ء  Dreamweaverيقوه 
ئئعت  ب لسي   ة   XPathئعبيفا  

ح لا  أوفت أيلً . بتى سبيا 
العث ا، ادا قع  بسحو باصف بليا 

الى رلوا يحئوي  XMLلبي ا   
لعا قا  XSL Tب لتعا بتى ب اة 

ئبفاف ع ب  بتيه، يعفض 
Dreamweaver   ًئتق ايXPath 

الح ل  ة   XPathت  بى العئع
-xsl:for>العلاع   الئلعيايا 

each> . 
 XMLاسئعفاض بي ا   

بالع  ئسئوله اسئعفاض ة  
 File>Preview inالعسئعفض )

Browser   لاسئعفاض بي ا )
XML  الئ  قع  بإلو لب  ة  رلء

XSL T  أو ة  صتحاXSL T 
عبئعتا، يوئتف العحفت الدي يقوه 

عة عوقف  XSLبإرفاء ئحويا 
لآوف. ب لاسبا لتصتح   الليا عيبيا 

، XSL Tالئ  ئحئوي بتى أرلاء 
ياتد و له الئ بيق   لااعً  الئحويا 
وة  أوق   أوفت، يعبة لى 
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Dreamweaver  أو لتعسئعفض
 الئحويا.

يتو  الرلوا الئ ل  العواقف بالع  
ئسئوله اسئعفاض ة  العسئعفض 

والعحفب   الئ  ئاتد الئحويلا  
 عايا.الع

 
 اوع الصتحا الئ  يسئعفلب  العسئعفض ئحويا البي ا   الدي ئاتدى

 
 XSL Tالصتحا الليا عيبيا الئ  ئحئوي بتى رلء  و له الئ بيق  

Dreamweaver  رلءXSL T  أو صتحاXSL T ب عتا 
 ب عتا XSL Tب فئب   لصتحا  XMLعتف  العسئعفض

 
ئوةف العولوب   الئ ليا اف  لا  
لتعس بل  ة  ئحليل أس ليو 
الاسئعفاض العلااعا، الق اعا بتى 

 احئي ر ئت.
 

عرض الصفحات للتحويلات من 
 جانب الخادم

ة  ح لا الئحويلا  عة ر او 
الو له، يفت اللااف العوقع ة  الاب يا 
العحئوت الدي يحوله و له 
الئ بيق  ، بال اا  ء صتح   

XSL T  وصتح   ليا عيبيا

للاسئولاه عع الئحويلا  عة ر او 
الو له يُتلا لااعً  اسئعفاض 
الصتحا الليا عيبيا الئ  ئحئوي بتى 

 XSLTبللًا عة رلء  XSLTرلء 
اتسه. ة  السيا فيو الس ب  ئسئوله 
و له الئ بيق  ، الدي يلعة أة 
اسئعفالت عئس  عع ع  سيفاى لاافو 
العوقع بال لي فئبه لتصتحا، وة  
السيا فيو الأويف، ياتد 

Dreamweaver  لاسئعفاض رلء
XSL T  أثا ء اا  ات له، لبات

سئبوة ق لفاً بتى فؤيا الائ ال الأبثف 
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   ادا با  ئسئوله لقا لإوفاج البي ا
و له الئ بيق   لعفض صتح ئت 

 .XSLTالليا عيبيا بعل الو لت لرلء 
 

استتتعراض الصتتفحات للتحتتويلات متتن 
 جانب العميل

ة  ح لا الئحويلا  عة ر او 
الععيا، يحوا العسئعفض العحئوي   
الئ  يفاه  لااف العوقع ة  الاب يا. 
يعبات ئاتيد دلت بإل ةا افئب   عة 

ادا  XSL Tالى صتحا  XMLعتف 
ة   XMLةئح  عتف 

Dreamweaver   واسئعفلئه ة
عسئعفض، ةإات ئربف العسئعفض 

وئاقيد  XMLبتى ئحعيا عتف 
الئحويا وهدا يرعتت ئعيش اتس 

 الئرفبا الئ  سيرفيب  لااف عوقعت.
وعع دلت، ةإة اسئولاه هدا العابل، 
يرعا الأعف أبثف صعوبا ة  
 اصلاح صتحئت، لأة عسئعفلت

ا  ء  XMLيقوه بئحويا   HTMLوا 
 Viewلاوتيً . ادا حلل  وي ف 

Source  ب لعسئعفض عة أرا
الدي ئه اا  ؤى،  HTMLاصلاح 

الأصت  الدي ئتق ى  XMLسئفت ةق  
الب عا  HTMLعسئعفلت، وليس 

)العلاع  ، والأاع   وغيفه ( 
العسؤوا بة بفض الصتحا لعفض 

HTML  الب عا بال بفض الئعتيعا
البفعريا العصلف، يرو بتيت بللًا 

 XSL Tعة دلت اسئعفاض صتحا 
 ة  عسئعفض.

الكاملة  XSL Tعرض صفحات 
 XSL Tوأجزاء 

ب عتا  XSL Tبال اا  ء صتح   
، سئفغو ة  بفض XSL Tوأرلاء 

بعتت لتئأبل عة بفض بي ا   
بصوف  صحيحا، ة  ح لا اسئولاعت 

 Preview in Browserلوي ف 
أو رلء  XSL Tلعفض صتحا 

XSL T ياتد ،Dreamweaver 
الئحويا ب سئولاه عحفت الئحويا 
العلعةَّ وئعاحت هدى ال فيقا ائ ال 
سفيعا، وئرعا عة الأسبا بتيت 
با ء صتحئت ب فيقا ئفابعيا 
صلاحب . بع  ئوةف لت  فيقا  وا 

الب عا )العلاع    HTMLلعفض 
ئحليل والأاع   وغيفه ( بة  في  
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ة   View Sourceوي ف 
 العسئعفض.

 HTMLو  Xmlالفرق بين  -1
XML  ئه ئصعيعه لب  يصف ويفبل

بتى البي ا   وع هيئب  )ئعفيتب (، 
HTML  ئه ئصعيعه لب  يعفض

 البي ا   ويبئه ب با بفلب  ةق .
ع دا يئورو بتيت ععفةئه لب  ئلفس 

 : XMLالى 
 HTML / XHTML. 
 JavaScript or VBScript. 

سوف ئرل لفوس لبدى التفوع ها  
Page Home 
 ؟ XMLع دا ئعا  الى 

 XML  اوئص ف ل  رعتا
Extensible Markup 

Language. 
 XML  بب ف  بةmarkup 

language  ئقفيبً  عثا الىHTML. 
 XML  ئه ئصعيعه لئعفيف

 البي ا  .
 XML  الئ ج الو صا ببدى الت ا

ليس  اةئفاليا اا  عة يحلل الئ ج 
 ه.الو صا ب

 XML  ئسئوله الىDTD 
(Document Type Definition )

ليئه ئوصيف  XML Schemaاو 
 البي ا  .

 XML  ععDTD  او XML 
Schema   ة ا  عة يحلل وصته
 الو   به.

 XML  ياصح به عة قبا الى
W3C. 

و  XMLالتفو  الفايسيا بية 
HTML 
XML    ئه ئصعيعه لب  ئحعا بي ا

 )أو ئاقا البي ا  (.
XML   ااه ليس بليا لHTML. 
XML  وHTML   ئه ئصعيعبه ل

 اهلاف عوئتتا.
XML    ئه ئصعيعه لب  ياقا البي ا

 عع ئعفيتب  ووصتب .
HTML  ئه ئصعيعه لب  يفبل بتى

 بفض البي ا   و فقه اظب فه .
HTML  ئقلف ئقوا ااه ئه ئصعيعه

 لب  يظبف البي ا   ةق .
XML .  ئه ئصعيعه لئعفيف البي ا 
XML .ااه لا يقوه ببا   ء 
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XML  ااه ليس ل ا ئتعيا با س ء
 ةبو عحلول.

XML   ئه ئصعيعب  لب  ئباى بب
احتظ  –ئاقا البي ا    –البي ا   

 البي ا   بب .
XML  ه  ل ا عر ايا وعئ حا

 لترعيع.
XML  ئ ج هدى الت ا ليس ععفف

واةئفال  با اا  ئعفف الئ ج 
 الو   بت.

 HTML الئير ة الئ  ة  ل ا الى
ععفةا واةئفاليا ولا ئسئ يع بعا 
ئ ج و   بت ةب  ئحئوي بتى ئ ج 

 (.P>, <h>, etc>لب  عثا )
XML  ئئيح لت اة ئقوه بئعفيف الئ ج

الو   بت واة ئقوه بئعفيف ال با 
الع ه لتعسئال ب فيقئت اا  عثلا 

 <wael>ئسئ يع بعا ئ ج اسعه 
My name  هدا اسعى<wael/> . 

ب ة ها ت ئير ة ة  العث ا الأوا 
( هدى <from> and <to>عثا )

ليس  ئ ج اةئفال  ة  الت ا ولباه 
ئ ج ئه ئعفيته عة قبا عة بئو هدى 

 الفس لا.

XML  ااه عئواة  ععHTML. 
XML  ولباه ليس بليا بةHTML. 

 XMLعة اللفوفي اة ئعفف اة الى 
 .HTMLبليا بة الى 

عة اللفوفي اة ئعفف اة ل ا الى 
XML قبا وحئى الاة لة ة  العسئ

يبوة لب  لوف غيف احئواء البي ا   
 او اقتب  او ئولياب .
عبعئب    HTMLوسوف ئظا ل ا الى

اة ئظبف البي ا   ةق  ولة ئقوه 
 بحتظب  او احئوااب .

XML  عسئقبا ئ ويف الويو عع الى
XML   ااب  ة   فيقب  لب  ئبوة ة

با عب ة لاة هدى الت ا عر ايا 
أي ل ا بفعرا وأي وعئ حا لتععا عع 

اظ ه ئ  يا ةب  عفاا ولبدا ة صبح 
 البثيف يعئعل بتيب .

 سبو ئوارله 
أفال العبفعرية اة يبوة ها ت  فيقا 
عفاا وسبتا لب  يقوعوا باقا البي ا   
بعوئتف ا ع لب  ببف هدى ال فيقا 
ةعثلًا اات ئول اة ئاقا بي ا   
العوظتية بالت عة ق بل  بي ا   
 فبا الى ق بل  بي ا   أوفت ةسوف 
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ئقوه بععا اوفاج لب  بتى  با عتف 
XML. 

ا عتت   اتئفض ايلً  أات ئول اة ئاق
ئحئوي بتى احص اي   ورلاوا 
وفس اا الى بفا عل اوف لإلاف  هدى 
العحئوي   ةسوف ئقوه بإوفارب  بتى 

 .XML با عتف 
ةب ة هدى الت ا ه   في  العبفعرية 
الى بعا وسيتا لحتظ البي ا   واقتب  
بأسبا ال في  وئئع عا عع عوئتف 
أاواع البي ا   وليس ق بل  البي ا   

اا البفيل ةق  او عتت   ةق  او فس 
 اصيا ةق .

 
 الاستنتاجات

1- XML    لب  ق بتيا احئواء البي ا
 HTMLواقتب  وئولياب  بتى ببس 

 عبعئب  اة ئظبف البي ا   ةق .
ة  العسئقبا سيئه ئ ويف الوو  -2

www  عع ل اXML  لأاب  ل ا
عر ايا وعئ حا الععا عع أي ل ا 

 أوفت وأي اظ ه ئ  يا لأاب  عفاا.

هدى الت ا  في  أثبئ   -3
لتعبفعرية الى بعا وسيتا لحتظ 
البي ا   واقتب  لأاب  ئئع عا عع أاواع 

 البي ا   وليس ق بل  البي ا   ةق .
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